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World war 1 activities for elementary students

By Emmanuelle Douglas Teaching PowerPoint the elementary students provide them with a skill set to show off their ideas in an outline form when they give reports and lectures at school. It can be used for book reports, science fairs, class lectures, and speeches. Simple and concise teaching of PowerPoint concepts allows kids to
preserve learned skills and apply them to a future project. Open PowerPoint 2010 and explain how PowerPoint appears to show the slide show to an audience. For example, a presentation is a book report, a science fair presentation, or a summer vacation report. To display an existing presentation, click the File tab, click Open, locate the
file, select it, and then press Open. Click F5 to show them your presentation. Explain to them how F5 helps them show the tutorial in full screen. Show that you can use mouse clicks to move the mouse click to the next slide. To stop the presentation, click the ESC button on the keyboard, and then click the File tab to close the presentation,
and then click Close. Click the New Slide tab and select New Slide to show them how to create a new slide. Click the text box on the new slide, and then type a name for your presentation; For example, if you're writing a book report about Harry Potter, type Harry Potter Book Report in the text box. Show them that your changes are
retained after you click different areas of the slide. Click the Insert tab and click Picture to add a picture to your slide show. Browse the picture you want to use on your computer. Click the picture and open to make the picture appear on the slide. Add another slide by clicking the Home tab and clicking New Slide. Click Layout to select the
layout. Explain to students that you use an outline layout to summarize the main topics in this section of the presentation, but the additional slides must be arranged in a way that matches each topic. Show them how to save your changes. Click the File tab, and then click Save As. Type a file name for the presentation. Explain how
important it is to know how to save and why you need to know where the file is going. While there may already be reasons you're passionate, gathering supporters and developing a thoughtful plan to enact change is just as important as the original idea. The timeline below can help novice activists develop a considered approach to
achieving their goals. Step 1 Pinpoint has a passion whether or not to protect the historic building of the college campus, ensuring fair treatment of animals, Fighting for LGBTQ equality, the most passionate student activists have identified the cause that makes them get up every morning believing they can make things better. Step 2
Educate Yourself Depending on your chosen selection with activism, there is a good chance that some others have identified this problem. First, find out if others are fighting for the same cause. If so, go to their website and read on the subject. To get full information, try positioning from groups on the other side. If you're already firmly in
control of the issue, you can check out if you can commit to a strategy of change or need to adopt a different approach. Step 3 Define your goal When you start to make others aware of the injustice you've identified, what action do you hope to encourage? You may want to get signatures to support a proposed government plan, or perhaps
you're more interested in raising public awareness. Either way, listing short, medium and long-term goals makes you organized and shows supporters that you've thought things through. Step 4 Touch resources Resources come in many forms, and one of the first types a student needs to find is peer groups. Activists looking for strength in
the numbers should start on campus, preferably reaching for an arm or staff member who advises. But don't be afraid to contact national groups. Many people have media strategies and toolkits full of organizational plans. Step 5 Establishment of an Action Plan: Consider the objectives that need to be in place to achieve this goal. Then
develop detailed action steps to meet the goals and achieve them. Step 6 Go! You've identified your passion, you've taught yourself, you've set goals, you've found resources, and you've created a plan for success. The final step to become a student activist is to get the attention that is your cause. This can mean speaking at student club
meetings, blogging, organizing a talking series, or meeting with the administration. Iconic scenes of protesters taking over the square or marching down a busy road pop into most people's minds when they think of activists, but there are several other ways to act to make a change. Internet activism Facebook sharing, hashtag campaigns,
mass tweeting: The world of social media and blogs has opened several doors to injustices known, and students can share information across accounts to maximize their achievement. Social media can be used to advance for almost any reason. Petitions Students can collect signatures in the old-fashioned way - standing in the middle of
the student union - or do it online. In both forms, petitions help students merge around a question and show leaders how many people believe in a cause. Petitions are often the first step for many different forms of activism. Media Use of media to raise awareness of the cause quickly potential supporters of the issue and move them to your
side. Campus radio shows, school newspapers and county billboards are all free advertising platforms. In addition, smartphones allow users to Videos. Boycotting the campus cafeteria using unsustainably grown products? Was there racial injustice in college houses? In these cases, boycotting a place (and getting others to do it with you)
can be an effective and quick method of garnering attention in your case. Protests take place in many different forms and serve different functions, depending on how they are used. Common examples of protests include remembrance vigils, patrols, rallies and marches. Strikes Unlike boycotts, where people who consume a good or
service (such as cafeteria food or a particular class) refuse patronity, strikes occur when workers or student workers refuse to work due to a policy or action deemed unacceptable. Sit-ins This protest movement popularized students during the civil rights movement. This includes space and refusing to leave until the requirements are met.
This method can be used for a number of reasons, from racial inequalities to longer library hours. Protests This collective method of activism involves gathering a large group of people and demonstrating discontent en masse, typically a march that ends in one place for a significant reason. For example, student activists protesting gender
discrimination in college sports may choose to end a parade in a major sports field where the speaker gathers in the crowd. Occupations The main difference between occupation and sit-in is that occupations typically take place in larger open spaces. Perhaps the best-known example of recent years occupy Wall Street. Civil disobedience
is taken widely used by Mahatma Gandhi, civil disobedience is a mostly nonviolent method of activism where participants deliberately violate rules, laws, or expectations that they morally disagree with. In student activism, civil disobedience can be used in matters relating to religious freedom and civil liberties. Student activists are at the
front of the championing of many issues. Whether they choose to address sexual health and safety, gender discrimination, religious freedom or other issues, they can draw inspiration and clarify their purpose by using the resources outlined in this section. Diversity and racism Although the civil rights movement began more than half a
century ago, racism and lack of diversity remain issues both on university campuses and across the country. In the context of higher education, bad race relations can fester, which ultimately manifests itself in distractions in learning or threats to student safety. Although these issues have improved significantly in recent decades, much
remains to be done. Environment &amp; Greening – or the enactment of environmentally friendly and sustainable policies – has been discussed on hundreds of university campuses in recent years. Whether you are pushing for more recycling encouraging faculty to switch to paper essays online as well, or installing water stations in
refillable bottles, there are many ways to promote the conservation of natural resources in higher education environments. 350.org I don't know how to promote training, structure a workshop, or launch a petition campaign? 350.org a database of activities activists can use, as well as primers for fossil fuel sales, offshore drilling and other
environmental flashpoints. EcoLeaders The National Wildlife Association has developed detailed student guides for planning environmental projects at the university. Equally important is that the web portal encourages students to join and implement projects on their campuses. Environmental Awareness in Crossroads: Green Activism in
America This piece by the Foundation for Economic Education discusses how to move the conversation about sustainability forward. UIC Office of Sustainability Many campuses now have sustainability classes so that student activists can partner to influence change. The university of Illinois' efforts have been particularly extensive. Check
out the Campus Resources section for ideas that can be implemented at the university or contact the Office of Sustainability school. LGBTQ &amp; Gender Equality The first widespread LGBTQ activism efforts began in the late 1960s and stemmed from broader issues surrounding second-wave feminism and the civil rights movement.
Student activists were on the front lines of this movement, and many campus LGBTQ groups began during that time. Issues that directly affect students include equal access to housing and transgender bathrooms. Politics &amp; Government decisions on the political scene have long been investigated by government officials as student
activists, with examples ranging from local government intervention in education to national issues like the Vietnam War. Many student-led political groups originated from other student clubs focused on conservative and liberal platforms. Sexual Health &amp; Safety Student activists run a gamut on issues related to sexual health, some
are working to expand abstinence programs in high school, and others are aiming to increase access to birth control. Sexual harassment is an area where most people get together to reduce the number of incidents by providing more security to campus and educating men and women about anti-bullying policies. Social Justice Movements
Broad concept, social justice deals with the mistreatment of the individual by society. In the case of student activism, this may apply to students mistreatment of school administration. Problems from racism and sexism to health care or education and students often join larger activist groups to amplify their collective voices. As they say,
learn to walk before you run. The same is true for students Students may fall into some common pitfalls if they hurry to install their plans. Use these tips and tricks to increase your chances of success: Leverage free publicity for extra money luxury in college, so finding stores to raise awareness for free is essential. We have a meeting with
supporters to determine whether someone is in contact with the student newspaper or radio station (or local news/radio station). Get on the same page Inspiring supporters is an important part of your success, but it's probably even more important to make sure everyone conveys the same information. The last thing a student movement
needs is a member who becomes a villain, so focus on talking points when the group communicates. Don't fall victim to discriminatory activism issues of discrimination as a common topic of student activism, and for good reason. No one should live in an environment where they feel discriminated against. But it's just as important not to
discriminate while protesting the same notion. For example, asking students to sign a petition for sexual assault policies is a worthwhile mission, but considering the anti-male stance undermines the basic message against discrimination. Remember the goals, objectives and action steps It's easy to get distracted as the movement grows or
develops, but maintaining a coherent message and remembering exactly what you said you wanted to accomplish will be the cause of your task. Students: Knowing your rights as an activist before you fight for any reason, it's important for students to understand their rights. While all Americans are eligible for free speech under the First
Amendment, some colleges dictate where free speech - be it handing out fliers, collecting signatures on petitions or patrols - can be done on campus. Some schools may even threaten students with suspension or expulsion because of certain types of activism. Students need to know their rights. The American Civil Liberties Union
provides a comprehensive guide to First Amendment rights and what students should do if they feel their rights have been violated. While ensuring that the law is amending or changing the president to create a new anti-discrimination task force can reach the news, minor acts of civic engagement can make a gradual difference in the
school community and the world. Here are some examples of what students of all ages are doing: Description Grade Levels Be Street Sweet Gather friends write inspirational messages on sidewalks that encourage goodwill in the community and reject violence. High school, high school, college Dream the Dream Research and share
applications for scholarships for undocumented students to help alleviate the anxieties of paying for college. High School, College Howl at Hearts Volunteer local animal shelter and share pictures of your new furry friends on social media or To encourage more pet adoption. Elementary, high school, high school, college Power to the Period
Provides women's care items for homeless shelters, so disadvantaged women get the products they need. High school, high school, college reuse, reduction, Recycle Challenge friends can opt for reusable water bottles that help protect the environment and reduce waste. Elementary school, high school, high school, college Unite voters
registration voters on campus so they can participate in the elections. High school, college student activists have been focused on social development for decades serving as instrumental participants in movements against sexism and racism and more civil rights and freedoms. College campuses are used to serve as incubators for these
movements, providing an environment where students discover their passions and develop skills to combat prejudice and inequality. While parents and educators can worry about these activities, there are many benefits to student activism in students, schools, communities and the nation. Eddie Thompson Eddie Thompson is no stranger
to activism. His parents started going to meetings when Eddie was young and worked on a number of local initiatives in Florida. It mobilized voters to choose like-minded candidates while also supporting specific changes in public policy. She plans to raise her children to be vocal and passionate activists. Activists.
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